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Preface

Thank you for placing your trust in this devolo product.

The devolo dLAN HS Ethernet is a HomePlug adapter for data communications
over the household electrical power supply network. With its Ethernet interface,
the dLAN adapter lets you set up or expand a home network easily and econom-
ically. Functions such as copying or moving files, using shared printers or access-
ing the Internet are all realized via existing power lines in your home. With the
dLAN HS Ethernet, any electrical socket in your home can be used as a network
connection—from the basement to the attic.

About this manual

This manual contains all the information you need about your dLAN HS Ethernet
from devolo. It tells you how to set up and configure your dLAN adapter. The 'All
about the home network' chapter also contains examples of applications for the
dLAN HS Ethernet and general information on dLAN networks.

Exacting manufacturing standards and stringent quality control are the basis for
high product standards and consistent quality to ensure your fullest satisfaction
with this dLAN HS Ethernet.

This documentation was compiled by several members of our staff from a variety
of departments in order to ensure you the best possible support when using your
product.

Additional information in the Internet at ‘www.devolo.com'

Our online services (www.devolo.com) is available to you around the clock
should you have any queries or require any further support.

Package contents

Please ensure that the delivery is complete before beginning with the installation
of your dLAN HS Ethernet:

@ dLAN HS Ethernet

@ Ethernet cable (3 m)

@ Printed information leaflet

@ (D with drivers, online documentation and application software

devolo reserves the right to change the package contents without prior notice.
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Description of the symbols
Here we briefly describe the meaning of the symbols used in this manual.

Very important notice which, if ignored, may lead to damage.

Important notice which should be heeded.

Addlitional information which is useful to know, but not vital.
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1.1

Introduction

In this chapter, we will provide an overview of the new dLAN technology and
introduce the dLAN HS Ethernet briefly.

What exactly is dLAN?

There is now a new alternative to the well-known wired LAN and Wireless LAN
network technologies currently used in home networking: dLAN (direct LAN, i.e.
directly networked). dLAN is home networking using the electric wiring already
installed in the building.

Cost factor and transmission quality

dLAN is an economical and easy-to-use networking technology. You don't need
to lay cables and you can connect to the home network at every power point.

The dLAN standard modulates and demodulates additional frequencies on the
power lines. Modulation and demodulation is a well-known and proven method
of data transmission, which has been in use in other applications for a number
of years. Now it is used to set up Internet and network accesses in the home or
office. Depending on the damping factor, distances of u to 200 meters can be
covered.

With a maximum data rate of up to 85 Mbps and symmetrical upload and down-
load speeds, dLAN is comparable to traditional Ethernet network solutions and
the current WIFI" wireless standard for home applications.

Data security and radiation

DESy, bit encryption is used, which guarantees secure data transfer within the
network.

dLAN devices from devolo meet the stringent EU industrial standards and com-
ply with the current standards for electromagnetic radiation.
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What does the dLAN HS Ethernet have to offer?

Powerful and flexible

For the first time, the dLAN HS Ethernet offers a transfer rate of up to 85 Mbps
over your household power supply grid. The new high-speed standard lets you
transfer large files between the computers of your network without long waits.
You can even send DVD-quality videos over your household grid. In conjunction
with IP-TV, you can experience video on demand throughout your house—any-
where an electrical outlet is available.

You can find examples of possible networks and general information in the
chapter "All about the home network .

Simple installation

@ Connect the dLAN HS Ethernet to the computer or the device with the Eth-
ernet cable.

@ Connect the dLAN HS Ethernet to the power supply grid.

@ |nstall the devolo dLAN software.

® That'sit!

Ethernet connection

The dLAN HS Ethernet adapter has an Ethernet port for connecting to a device
in the home network (e.g. computer, notebook, modem, router, switch etc.). The
euro AC power plug connects to your household power supply grid.

Status display

The control lamps (LEDs) of your dLAN HS Ethernet display the connection sta-
tus, and provide status regarding the function of the data transmission. The
dLAN HS Ethernet features 6 status lights.
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Connection and startup

This chapter covers the connectors and display elements of your dLAN HS Eth-
eret and explains how to connect the device.

System requirements

Your computer must meet the following requirements to operate with your dLAN
HS Ethernet:

@ Operating systems: Windows 98, Windows Me, Windows 2000, Win-
dows XP, Linux, Mac OS X or any other operating system with network sup-
port

@ Ethernet connection

Please note that your computer or other device must feature a network adapter
with an Fthernet port.

Connection and display elements

The dLAN HS Ethernet adapter has six indicator lights (LEDs) and an Ethernet
port:

® ETH

O 100/Act: Is lit whenever an Ethernet connection exists; flashes to signal
100 Mbps data rate.
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O 10/Act: Is lit whenever an Ethernet connection exists; flashes to signal
10 Mbps data rate.

O Col: Flashes at a faster rate if the network is experiencing increasing
use.
® dLAN
O Power: Is lit when the dLAN HS Ethemnet is ready for operation.
O Act: Flashes when data are being sent or received over the power lines.
O Link: Is lit if connected to the dLAN network.
@ Ethernet connection: This is the connection point on the dLAN HS Ether-

net for connecting it to a computer or another device with the network cable
(included).

Make sure that all of the dLAN adapter that you want to add to your network
are also connected to the power supply grid. After about 15 minutes, a dLAN
adapter switches into stand-by mode unless there is an active device connected
to the Fthernet interface. dLAN aaapters in stand-by mode are not accessible
over the power supply grid.

Connecting the dLAN HS Ethernet

In this section, we will show you how to connect the dLAN HS Ethernet to a com-
puter.

Before connecting the dLAN HS Ethernet, note its security ID and keep it ready
for configuring the network. You can find the security ID on the bottom of the
dLAN adapter.

@ With the computer running connect the dLAN HS Ethernet to an Ethernet
port of the computer with the network cable (included).

@ Plug the dLAN HS Ethernet adapter into a convenient power socket.

® Continue with the installation of the devolo dLAN software. For more infor-
mation, refer to the chapter on ‘devolo dLAN software".

No drivers are required for running the dLAN HS Fthemet.
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3.1.3

devolo dLAN software

This chapter introduces you to the dLAN configuration wizard, Informer, Easy-
Share and EasyClean devolo tools. It describes how to install them and how to
configure your dLAN network.

Overview of the devolo software

dLAN configuration wizard

The dLAN configuration wizard helps you to build and change your encrypted
dLAN network. With its help, you can add dLAN adapters to your network. It
allows you to configure all dLAN adapters on the network from a central loca-
tion, such as from a single workstation. For the encryption process, you need the
security IDs of the dLAN adapters (provided on the underside of unit) and a net-
work password of your choosing, which you will assign.

The password set up initially by devolo is HomePlug.

You will find the software and notes about the installation of the dLAN config-
uration wizard for Mac and Linux on the supplied devolo product CD.

Informer

The Informer displays information about all dLAN devices in your network, such
as their MAC addresses for dLAN and current transfer speeds.

The MAC address (Media Access Control) is a serial number and unique. It is
programmed into the hardware and cannot be changed. The MAC adaress for
ALAN can be found on the underside of the dLAN adapter.

EasyShare

EasyShare is a file-sharing and chat tool for your local network. It allows you to
exchange files easily between local Windows computers. The chat function
allows instant communication between all network users.

EasyClean

Microsoft Internet Explorer stores files in a cache on your hard drive while you
surf the Internet. With EasyClean, you can determine which of these unwanted
files you would like to delete.
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Installing the devolo dLAN software

@ Put the enclosed devolo product CD in your CD-ROM drive.

@ From the CD setup, select 'Install dLAN software’. Windows starts the wiz-
ard. Confirm by clicking Next.

® Select 'Standard Installation’ to install the complete devolo dLAN software
package. Then, click Next.

If you would like to choose the software components to be installed yourself,
select ‘Custom Installation’. Then, click Next.
@ Terminate the installation by clicking Finish.

(B After the installation has been completed successfully, start the devolo tools
by clicking Start > Programs »> devolo »> dLAN configuration wiz-
ard, EasyShare, Informer or EasyClean.

Configuration of the dLAN network using the
dLAN configuration wizard

Please have the previously noted dLAN aaapters security I1Ds ready. The dLAN
contiguration wizard requires them for configuration of the network. You wifl
find the security ID on the bottom of the device.

@ Start the dLAN configuration wizard under Start » Programs > devolo
» dLAN configuration wizard.

@ Confirm with Next. The dLAN configuration wizard starts the network anal-
ysis and searches for dLAN adapters on your network.

Make sure that all of the dLAN aaapters that you want to add to your network
are also connected to the power supply grid. If no active device is connected to
the Fthernet port, a dLAN adapter will go into standby mode after about 15 min-
utes. It cannot be configured while in standby mode.

® In the following dialog box select a common password for your dLAN net-
work and confirm your input with Next.

The password set up initially by devolo is HomePlug.

@ The dLAN adapters connected directly to your computer is detected auto-
matically. All other dLAN adapters have to be entered manually. Enter in
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sequence the security IDs of the dLAN adapters that are to be included into
a network and click Add. Click Next when you have entered all desired
dLAN adapters.

dLAN Configuration Wizard E|

Add dLAN adapters
Add other dLAN adapters that are addressable via the power supply grid,

To add dLAN adapters that are addressable via the
power supply ko your network, enter their security IDs "‘-“f‘_"" C €
and click the Add buttan, LAN

Sacurity 10:]
The security 1D is printed on a small label on the A A
battom of the adapter. . I

Security I0:
[HarD .;.I.WARE "I.E-EINS |-[ 230

Add = 100:08:38:55:23:02 {on this computer)

[ < Back ][ Mext = ][ Cancel ]

(® Exit securing your network by clicking Finish. Your dLAN network is now
secure against unauthorized access from outside.

The configuration of the dLAN network can be changed or updated at any time.
70 do this repeat the configuration process as described above.

=o
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3.4

Overview in the dLAN network with the Informer

Due to the Informer you always have an overview of all dLAN adapters in your
dLAN network. The Informer shows the dLAN adapter connected directly to the
computer as well as all dLAN adapters that are included into the same dLAN
network.

®_ devolo Informer

Device Wiew Help

4 dLan Hs Ethernet
€ MaC address: 00:08:36:0C:2B:E2

The Informer displays information about all dLAN devices in your network, such
as their MAC addresses for dLAN and current transfer speeds. Via Device
Rename you can change the name of the selected device.

Right-clicking on one of the dLAN adapters opens a context menu in which the
following commands are available:

@ ‘'Rename’ opens a dialog in which you can assign a new name to the device.

@ ‘Start dLAN configuration wizard' opens a dialog in which you can add new
dLAN adapters to the dLAN network and assign the network password.

Informer displays only those dLAN adapters that are connected to the power
supply and added to your dLAN network. After about 15 minutes, a dLAN
adapter switches into stand-by mode unless there is an active device connected
to the Fthernet interface. dLAN adapters in stand-by mode are not shown in
Informer.
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3.5

3.5.1

Communication in the network using EasyShare

All users on the local network who have started EasyShare are automatically rec-
ognized by the program and listed:

'L devolo CasyShare

| l.‘.I.IE - Stas | oSt
Drdstastect_devolo don_du_enp Fnished  Marketng

Configuration

The EasyShare software provides two easy wizards, which will guide you quickly
and easily through the configuration process: the first setup wizard, which starts
automatically the first time the program is started, and the sharing wizard,
which allows you to add shared items at any time. The individual functions of
the EasyShare software are described here:

Folder sharing

To share data with others, a EasyShare network user has to make the data avail-
able in a shared folder. When a folder is shared, all of its files as well as the files
of all its subdirectories become available to all users on the EasyShare network.
Folders can be shared either by using the initial setup wizard, which opens auto-
matically the first time the EasyShare is started, or by using the sharing wizard.
You can open the sharing wizard by clicking the Add share button, or by select-
ing File > Add share from the menu.

(| devolo dLAN Highspeed Ethernet |
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Options

Every computer has a name. When EasyShare is first installed, you can assign a
new name to your computer or use the default name suggested by the operating
system. Your computer is visible by this name to all EasyShare users.

The computer name can be changed at any time by clicking the Options button
or by selecting Tools » Options from the menu.

Refreshing shared folders

To view (newly) shared folders of other EasyShare network users, select File »
Refresh from the menu, or Refresh from the context menu (right mouse but-
ton). The contents of all shared folders will appear in the top right-hand win-
dow.

Downloading files

To download shared files from other EasyShare network users, select the com-
puter belonging to the user and then mark the shared folder for that user. The
upper-right window then lists all the contents of the folder. From the list, mark
the files and/or folders that you want to download and then select File b
Download from the menu, or Download from the context menu (right mouse
button). Choose a target folder on your computer and confirm by clicking OK.
The files are now downloaded to your computer. The status of the download is
displayed in the lower-right window entitled 'Data transfer in process'.

Data transfer in process

All 'Data transfer in process' are displayed in the lower right window and disap-

pear from the screen once they are finished.

@ The 'Name' column indicates the name of the file being downloaded.

@ The 'Status' column shows the current transfer progress and the transfer
speed.

@ The 'Host' column shows the computer from which the file is being down-
loaded, or to which it is being uploaded from your computer.

You can cancel the current download by clicking the file and selecting Cancel
from the context menu (right mouse button).

Chatting

The lower left window functions as a chat room, which is visible and accessible
to all EasyShare users on the local network. Users can "chat" by writing mes-
sages and clicking Send.
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3.6 Maintain your privacy with EasyClean

With EasyClean, you can delete the cached files listed below. Select the check-
boxes of the file types you would like to remove, then click Delete.

# devolo EasyClean @

Please select the data for deletion.

Internet Explorer

@ Cookies are small files that can be used to store the settings for web sites, e.qg.
ordered goods,

Delete temporary Internet files

Internet Explorer stores the files from web sites to accelerate the display of the
pages.

Delete hiskory

Every web site that you visited in the last bwo to three weeks is stored in the
History Folder,

Delete stored Form data

The Internet Explorer provides the option of filing in your entries automatically,
Ta da this, it remembers the data that you type in.

Delete stored passwords
The Internet Explorer provides the option of filing in your access data
automatically.

File: lists
[ :‘ Delete the list of recent files
Warious lists of the files recently opened or websites recently visited are saved

on the computer, These include the address list in the Internet Explorer and the
list of recently run programs,

[ Delete ] [ Close ]

® Cookies—Many websites store small files on your computer, so-called
cookies. These files may contain personal information such as log-in data,
passwords or credit card numbers.

® Temporary Internet files—Temporary files are stored on your hard drive
while you surf the Net. Over time, these files take up a considerable amount
of space.

@ History files—Internet Explorer records your surfing activity over a period
of days or weeks. This can be practical, but it also takes up space and can
be undesirable in many cases.

@ Stored form information—Internet Explorer stores information that you
enter in forms and can auto-complete this information in the future.

(| devolo dLAN Highspeed Ethernet |




[ devolo dLAN software

=0

@ Stored passwords——Passwords can also be stored and automatically
inserted together with usernames in subsequent log-in procedures. While
this is convenient, it's also dangerous—especially in connection with bank
transactions. Sensitive information such as this should only be stored locally
in special programs designed for this purpose.

® Document history—Internet Explorer maintains lists of open documents
and visited websites. This information is generally no longer needed.

Please note that FasyClean only supports Microsoft Internet Explorer.
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4 All about the home network
This chapter contains examples for possible home network designs and general
information.

4.1 Internet ADSL standalone solution—Option 1

Workstation with Internet connection over an ADSL modem

ADSL modem

4.2 Home networking—Option 2

Connection of workstations and a high-speed IP-TV application to the Internet
via a LAN router and an ADSL modem

ADSL modem
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4.3 Home networking—Option 3

Connection of workstations and a high-speed IP-TV application to the Internet
via dLAN ADSL modem router

4.4 Home networking—Option 4

Connection of workstations and a high-speed IP-TV application to the Internet
via dLAN ISDN router

devolo dLAN ISDN Router
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4.5 Worth knowing

Network traffic — The maximum number of dLAN adapters that can partici-
pate in a network at the same time is theoretically much higher than the 10
devices recommended for practical reasons.

Compatibility — The dLAN adapters by devolo are compatible to all other
devolo LAN products, to all devices conforming to the IEEE 802.3 standard and
to other HomePlug devices.

Network security — dLAN adapters use internal DS, encryption to guaran-
tee the security of the network. Individual security settings are managed by the
dLAN Configuration Wizard. For more information, refer to the chapter on
‘devolo dLAN software'.

For more answers to frequently asked questions (FAQs), please visit our website
at www.devolo.com.

=IO
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5 Appendix

5.1 Technical data

This table has detailed information for those interested.

dLAN HS Ethernet

Standards Ethernet specification IEEE 802.3, IEEE 802.3x, IEEE 802.3u
Auto MDI/X
compatible to HomePlug standard 1.1

Protocols CSMA/CD

Transfer rate up to 85 Mbps

Transfer procedure Asynchronous

Modulation OFDM—84 carrier

Range up to 200 m via power supply

Security DESy encryption via power supply

LEDs 1x3 status HomePlug ports

(107100, Link/Act, Collision-Detection)
Ethernet Link-Act

dLAN connection Standard power plug

Computer interface RI45

Power consumption 4.5 VA (max.)

Power supply Integrated power supply via power socket

Rated voltage: 110 - 230 VAC
Rated current: 0.13 A
Rated frequency: 50 Hz

Environment Humidity (non-condensing): 10-90%
Storage: -25°C—70°C
Operation: 0°C —40°C

System requirements Ethernet interface

Windows 98, Windows Me, Windows 2000, Windows XP,
Linux, Mac OS X or any other operating system with network
support

CE conformity CE-compliant in accordance with the technical requirements
of R&TTE for all EU countries and Switzerland

Design Plastic housing
80 x 63 x 37 mm (height x width x depth)

Warranty 3 years
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5.2 Device care and maintenance
There are no user-serviceable parts within the housing of the device. Never open
the housing.

To clean the device housing of soil, use a damp cloth or a lens-cleaning towel.
Never clean the dLAN HS Ethernet using water, thinner, benzene, alcohol or any
sharp cleaning aids, as these materials can damage the housing.

5.3 CE conformity
This product complies with the technical requirements of the 1999/5/EC Direc-
tive (R&GTTE) and the other relevant provisions of the FTEG, and it is designed for
use in the EU and Switzerland.

The product is class B equipment. This equipment may cause interference with
radio waves in home use; if this occurs the operator may be required to take cor-
rective action.
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5.4 Declaration of conformity

C€

KONFORMITATSERKLARUNG

Hersteller:
Manufacturer:

Produkt:
Product:

Typnummer:
Type number:

Verwendungszweck:
Intended purpose:

Richtlinie:
Directive:

DECLARATION OF CONFORMITY

devolo AG
Sonnenweg 11
52070 Aachen

devolo dLAN®Ethernet High Speed 85
MT2071

PLC zu Ethernet

PLC to Ethernet

EMV 89/336/EEC

Das Produkt entspricht den grundlegenden Anforderungen und Bestimmungen der
folgenden Normen und Methoden:
The product complies with the essential requirements and provisions of following standards and methods:

Sicherheitsanforderungen:
Safety requirements:

Immunitatsanforderungen:
Immunity requirements:

Emissionsanforderungen:
Emission requirements:

EN 60950-1:2001

EN 55024:1998+A1:2001+A2:2003

EN 55022:1998+A1:2000+A2:2003 (class B)
und Expert Opinion vom Competent Body EMC
and Expert Opinion by Competent Body EMC

Diese Erklarung wird verantwortlich abgegeben durch:

This declaration is submitted by:

Aachen, 5. Mai 2006
Aachen, 5" Mai 2006

A

Heiko Harbers
Vorstandsvorsitzender
CEO
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5.5 Warranty conditions

The devolo AG warranty is given to purchasers of devolo products in addition to the warranty con-
ditions provided by law and in accordance with the following conditions:

1 Warranty coverage

a) The warranty covers the equipment delivered and all its parts. Parts will, at devolo's sole dis-
cretion, be replaced or repaired free of charge if, despite proven proper handling and adher-
ence to the operating instructions, these parts became defective due to fabrication and/or
material defects. Alternatively, devolo reserves the right to replace the defective product with
a comparable product with the same specifications and features. Operating manuals and pos-
sibly supplied software are excluded from the warranty.

b)  Material and service charges shall be covered by devolo, but not shipping and handling costs
involved in transport from the buyer to the service station and/or to devolo.

) Replaced parts become property of devolo.

d) devolo is authorized to carry out technical changes (e.g. firmware updates) beyond repair and
replacement of defective parts in order to bring the equipment up to the current technical state.

This does not result in any additional charge for the customer. A legal claim to this service does
not exist.

2 Warranty period

The warranty period for this devolo product is three years. This period begins at the day of delivery
from the devolo dealer. Warranty services carried out by devolo do not result in an extension of the
warranty period nor do they initiate a new warranty period. The warranty period for installed
replacement parts ends with the warranty period of the device as a whole.

3 Warranty procedure
a) If defects appear during the warranty period, the warranty claims must be made immediately,
at the latest within a period of 7 days.

b) In the case of any externally visible damage arising from transport (e.g. damage to the hous-
ing), the person carrying out the transportation and the sender should be informed immedi-
ately. On discovery of damage which is not externally visible, the transport company and the
sender are to be immediately informed in writing, at the latest within 3 days of delivery.

) Transport to and from the location where the warranty claim is accepted and/or the repaired
device is exchanged, is at the purchaser's own risk and cost.

d) Warranty claims are only valid if a copy of the original purchase receipt is returned with the
device. devolo reserves the right to require the submission of the original purchase receipt.

4  Suspension of the warranty
All warranty claims will be deemed invalid
a) if the label with the serial number has been removed from the device,

b) if the device is damaged or destroyed as a result of acts of nature or by environmental influ-
ences (moisture, electric shock, dust, etc.),

¢) if the device was stored or operated under conditions not in compliance with the technical
specifications,

d) if the damage occurred due to incorrect handling, especially to non-observance of the system
description and the operating instructions,

e) if the device was opened, repaired or modified by persons not contracted by devolo,
f)  if the device shows any kind of mechanical damage, or
g) if the warranty claim has not been reported in accordance with 3a) or 3b).
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5 Operating mistakes

If it becomes apparent that the reported malfunction of the device has been caused by unsuitable
hardware, software, installation or operation, devolo reserves the right to charge the purchaser for
the resulting testing costs.

6 Additional regulations

a) The above conditions define the complete scope of devolo's legal liability.

b)  The warranty gives no entitlement to additional claims, such as any refund in full or in part.
Compensation claims, regardless of the legal basis, are excluded. This does not apply if e.g.
injury to persons or damage to private property are specifically covered by the product liability
law, or in cases of intentional act or culpable negligence.

¢)  Claims for compensation of lost profits, indirect or consequential detriments, are excluded.

d) devolo is not liable for lost data or retrieval of lost data in cases of slight and ordinary negli-
gence.

e) In the case that the intentional or culpable negligence of devolo employees has caused a loss
of data, devolo will be liable for those costs typical to the recovery of data where periodic secu-
rity data back-ups have been made.

) The warranty is valid only for the first purchaser and is not transferable.

g) The court of jurisdiction is located in Aachen, Germany in the case that the purchaser is a mer-
chant. If the purchaser does not have a court of jurisdiction in the Federal Republic of Germany
or if he moves his domicile out of Germany after conclusion of the contract, devolo's court of
jurisdiction applies. This is also applicable if the purchaser's domicile is not known at the time
of institution of proceedings.

h)  The law of the Federal Republic of Germany is applicable. The UN commercial law does not
apply to dealings between devolo and the purchaser.
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